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Key'Services'&'Information'

• Circulation Policy – Borrow books for four months, bound journals and media for one week 
• Interlibrary Loan http://www.lib.umt.edu/ILL 
• Document Delivery http://www.lib.umt.edu/DocDel 
• Bibliographic Management Software – RefWorks and EndNote Basic 
• Study Carrels http://www.lib.umt.edu/services/study-areas/carrels 
• Workshops http://libguides.lib.umt.edu/workshops 

!
!
Research'Resources 

Access all library electronic resources remotely via your NetID and password. 
 
Indexes'
Dissertations & Theses, ProQuest Digital. Indexes doctoral dissertations and master’s theses back to 1637. 
Most dissertations from 1997 forward are available in full-text. 
 
PsycINFO. Abstracts and citations to the scholarly literature in the psychological, social, behavioral, and 
health sciences. There are over 3.3 million records in the database. Coverage is from 1806-present; there are 
less than 146 records with publication dates prior to 1890. The PsycINFO Thesaurus file within the database 
consists of more than 8,200 standard and cross-referenced terms derived from the print Thesaurus of 
Psychological Index Terms, 11th edition (2007). The thesaurus terms are critical for advanced searching of the 
database. Cited references data available from 2001 forward. 
 
PubMed (National Library of Medicine). Abstracts and citations to approximately 20 million biomedical 
literature items from MEDLINE, life science journals, and online books; approximately 5,400 journals 
published in more than 80 countries. Coverage is from 1950-present. MeSH (Medical Subject Headings) are 
critical for advanced searching of the database. 
 
Web of Knowledge/Web of Science. Indexes over 1,950 journals from 50 social science disciplines, as well 
as 3,300 scientific and technical journals, and conference proceedings. Index is the online version of the Social 
Sciences Citation Index, Science Citation Index, and Arts & Humanities Citation Index. Coverage is from 1898-present. 
One of the key features of this index is the ability to do a ‘Cited Reference Search’. 
 
WorldCat. Indexes materials at the Mansfield Library and thousands of other libraries around the world. 
 

Full'Text'Databases'
The Cochrane Library. Includes independent evidence to inform healthcare decision-making, including 
systematic reviews, clinical trials, technology assessments, economic evaluations, individual clinical trials, and 
more. There are 130 under the heading Developmental, Psychosocial, & Learning problems, and 406 under 
Mental Health. 
 
Mental Measurements Yearbook with Tests in Print. Includes both a comprehensive guide to over 2,000 
contemporary testing instruments with test purpose, publisher, pricing, and edited reviews (Mental 
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Measurements Yearbook) and a bibliography of commercially available tests with test purpose, publisher, in-
print status, price, acronym, intended population, publication dates, and authors, etc. (Tests in Print). 
 
PsycARTICLES. Full-text articles from the over 70 journals published by APA, the APA Educational 
Publishing Foundation, the Canadian Psychological Association, and Hogrefe & Huber. Most journals are 
covered from the initial volume and issue of publication of the journal. 
 
PsycBOOKS. Full-text of over 3,400 books and 50,825 book chapters published by APA, as well as classic 
resources in Psychology and out-of-print titles. Includes the 8-volume 1,500-entry APA/Oxford University Press 
Encyclopedia of Psychology. 
 
Psychiatry Online. Includes the complete DSM-V Diagnostic and Statistical Manual of Mental Disorders 
psychiatric reference, journals, textbooks, practice guidelines, self-assessment tools, and medication handouts 
from the American Psychiatric Publishing, Inc. 
 
ScienceDirect. Primarily scientific full-text articles from roughly 2,500 journals; roughly 170 Psychology titles. 
Database also includes some books. 
 
SpringerLink EJournals. Multidisciplinary full-text articles from over 2,700 journals; 151 Psychology titles. 
 
Wiley-Blackwell EJournals. Multidisciplinary full-text articles from roughly 1,500 journals; 70 titles are 
categorized under Clinical Psychology. 
 
Select other full text databases include: Annual Reviews (reviews of research literature), Counseling and 
Therapy in Video (streaming videos for studying social work, psychotherapy, psychology, and psychiatric 
counseling), Psychology & Behavioral Science Collection (journals on emotional and behavioral 
characteristics, psychiatry & psychology, mental processes, anthropology, and observational & experimental 
methods), SAGE Online Journals (multidisciplinary), and Taylor & Francis Journals (multidisciplinary). 
 
 
Locating'Journals'and'Article'Citations'

If you are looking for a specific article (e.g., from a reference list) or a specific journal, the first step is to find 
out if the library subscribes to that journal, either online via a database or in print. Enter the name of the 
journal in the main search box on the library homepage, then choose Journal Titles from the Search In pull-
down menu. This will show you if the library provides access to the journal in a database, in UM Print 
Holdings (paper copies), and or indicate that the library does not subscribe to the journal. If the library 
subscribes to the journal, be sure to check the dates of coverage that are available. If the library does not have 
a subscription to the journal you can request specific articles from the journal via Interlibrary Loan 
(http://www.lib.umt.edu/ILL). If the library only owns the journal in paper you can request that it be 
scanned and emailed to you via Document Delivery (http://www.lib.umt.edu/Docdel). 
 
If you want to know what journals are highly regarded in the field of Clinical Psychology, one measure is 
impact factor. You can locate journals with high impact factors in the database Journal Citation Reports 
(JCR). For each journal you will see how many articles were published in it, how many times articles from the 
journal were cited, a one-year and five-year impact factor ranking, and additional metrics. Note that JCR does 
not cover all published journals. Also note that the increased sharing of research online via blogs, faculty 
websites, institutional repositories, etc., has led individuals to develop alternative metrics for measuring 
scholarly impact (e.g., http://altmetrics.org/manifesto/).  
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Managing'Your'Research:'Citation'Management'Software'

Citation Management Software can help you manage your research and format citations. You can use citation 
management software to: create your own personal database to keep track of your research articles, 
documents, websites, etc.; import citation information from a variety of resources into your database; 
automatically generate a bibliography in a variety of styles (e.g., APA, ASA, Chicago, MLA); and add in-text 
citations to a paper in a variety of styles. The two web-based tools the library provides are EndNote Basic 
and RefWorks. Find our more at: http://libguides.lib.umt.edu/endnoteweb and 
http://libguides.lib.umt.edu/refworks. The table below provides basic information to get you started. 
!

! EndNote'Basic' RefWorks'

Access' Via the “Databases, A-Z” link on the homepage. Via the “Databases, A-Z” link on the homepage. 

Capacity' 50,000 references; top 3,300 bibliographic styles Unlimited references; 800 bibliographic styles 

Set'up'an'

account'

Requires the use of your official UM email 
address. Your password must include at least 
one letter, number, and symbol. No special code 
is required for off-campus access but you need 
to initially register for an account from an on-
campus location. 

Requires the use of your official UM email 
address. Off-campus access requires a Group Code 
that will be sent to you when you set up your 
account and can be re-sent to you if you send an 
email from your university account to 
refworks@umontana.edu. 

Add'

citations'

Manually under the “Collect” menu, “New 
Reference.” Export data from various databases, 
usually under “Export” or “Save Citations.” In 
some instances this is seamless (e.g., using Web 
of Science), in other instances you need to 
download the data and then use the “Import 
References” option under the “Collect” menu. 

Manually under the “References” menu, “Add 
New” or via the “New Reference” button. 
Export data from various databases, usually 
under “Export” or “Save Citations.” In some 
instances this is seamless (e.g., using CSA 
databases), in other instances you need to 
download the data and then use the “Import” 
option under the “References” menu to add the 
reference data. 

Organize'

citations'

Use the “Organize” menu, “Manage My 
Groups”, to group references into folders by 
topic, project, etc. A citation can be placed in 
more than one folder. Folders can be shared 
with other EndNote Web account holders. 

Select the “New Folder” button. A citation can 
be placed in more than one folder. Select the 
“Organize & Share Folders” tab to make 
changes. Folders can be shared with RefWorks 
and non-RefWorks account holders via email, 
URL, or in UM’s RefWorks RefShare area. 

Find'

citations'in'
your'account'

Use the “Quick Search” menu on the “My 
References” page. 

Use the “Search” box. Citations can also be 
sorted in a number of ways such as by author, 
title, and journal. 

Create'

inQtext'

citations'

Requires you to download the “Cite While You 
Write” plug-in for your computer that works 
with MS Word programs on PC and Mac 
applications. Find the utility under the “Format” 
menu – “Download Installers.” 

Requires you to download a utility program to 
your computer called “Write-N-Cite” that works 
with MS Word programs on PC and Mac 
applications. Find the utility under the “Tools” 
menu. 

Bibliography' Under the “Format” menu choose 
“Bibliography.” 

Use the “Bibliography” menu or the “Create 
Bibliography” button. 

Get'help' Tutorials are available at 
http://www.youtube.com/user/EndNoteTraini
ng; “Help” menu and “Getting Started Guide”. 

Tutorials are available at 
www.youtube.com/proquestrefworks; “Help” 
menu. 
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Keeping'Current:'Current'Awareness'Services!
Current Awareness Services help you keep on top of what is being published in your research area, or by 
specific authors or in specific journals, by automating research practices. These services are provided free by 
most publishers and database vendors, and some search engines; often they require registration. You can 
select how often to be updated (e.g., monthly) and how, usually options are via email or a RSS feed. Here are 
a few details: 

• Table of Contents Alerts. Receive an alert each time a new issue of a journal is published. 
(JournalTOCs is a website service through which you can sign up for multiple alerts 
http://www.journaltocs.hw.ac.uk/.) 

• Saved Search Alerts. Receive notice when new articles come into a database that fit your search query. 
• Cited Reference Alerts. Receive notice when a new publication cites a particular article or text. 
• News alerts. Receive alerts from newspapers, government institutes, etc.; anywhere you see the RSS 

icon. 
• Google and Yahoo! Alerts. Set up a search query and have the results emailed to you. 

 
Some RSS readers include: Feedly, Bloglines, The Old Reader, Reeder 
 
 
 

Upcoming)Library)Workshops!

!

Literature!Review:!Effective!Searching!and!Writing!Strategies.!In!collaboration!with!the!Writing!Center,!this!

session!will!present!a!strategic!approach!to!the!literature!review,!including!search!techniques!and!writing!

strategies.!

@!Tuesday,!October!1,!3:10@4:30pm,!Mansfield!Library!283!Student!Learning!Center!

!

Manage!Your!Research!with!RefWorks.!Hands@on!workshop!on!how!to!utilize!the!bibliographic!management!tool!

RefWorks!to!organize!your!research,!store!citations,!and!create!bibliographies.!

@!Tuesday,!October!8,!3:10@4pm,!Mansfield!Library!283!Student!Learning!Center,!or!

@!Saturday,!October!12,!11:10am@noon,!Mansfield!Library!283!Student!Learning!Center!

!

Data!Management!Plans.!Join!Scott!Whittenburg,!Vice!President!for!Research!&!Creative!Scholarship,!and!

Mansfield!Library!Librarians!to!discuss!tools,!resources,!and!strategies!for!creating!data!management!plans!for!

proposals!to!NSF!and!other!agencies.!This%workshop%is%part%of%the%Faculty%Development%Office’s%Professional%
Development%Series;%RSVP%at%http://www.umt.edu/fdoevents.!
@!Friday,!October!25,!1:10@2pm,!Mansfield!Library!284!Buckhous!Room!

!

Keep!Current.!Want!to!stay!up@to@date!on!new!research!and!trends!emerging!in!your!field?!Find!out!about!RSS!

feeds!and!Table!of!Contents!alerts!as!well!as!saved!searches!and!how!to!utilize!these!awareness!services!and!

database!features!to!stay!current!in!your!research.!

@!Friday,!November!1,!3:10@4pm,!Mansfield!Library!283!Student!Learning!Center!

!

Registration!is!required!to!secure!your!enrollment!and!provide!us!with!contact!information!in!case!of!last!minute!

changes:!http://www.lib.umt.edu/forms/workshops.!Walk@ins!welcome!if!space!is!available.!

!

! !


